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Introduction

CorporateTime is a course created for CAL PACT participants to learn the
introductory skills necessary to work with the CorporateTime software. The
course covers both the Windows and Macintosh computer platforms. This
document serves as a supplement and future reference to the class.

Skills needed to take this class

�  how to use the mouse

�  experience with the Windows or Macintosh operating system

Skills and concepts learned in this class

�  signing in

�  changing user information and passwords

�  accessing help

�  searching for users, resources, or groups

�  working with the Agenda

�  scheduling events, notes, and tasks

�  working with events, notes, and tasks

�  working with the In-Tray

�  creating and managing groups

�  working with reminders

�  setting access rights

�  setting user preferences

Conventions used in this document

Menus and menu commands are separated by a vertical bar (|).  In the
document they will appear as Menu|Command.  An example of this is
�Select File|New...�
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Starting Up and Signing On

Upon opening
CorporateTime,
the dialog box
shown at right will
appear. Enter the
username and
password. In the
server name field, choose the appropriate server setting or choose the �Off-
line� option if a network connection is not available.

In the CorporateTime window, a graphical indicator in the status bar is also
available to show current program status.

This indicates that the program is running off-line.
This indicates that the program is running on-line.

   This indicates that there are new entries in the In-tray.

Signing on as a resource

When signing on as a resource, you have the ability to change the access
rights and password.

Changing User Information and Passwords

To change the user information that is available for others to see, select
Option|User Information; to change the password, select Options|Change

Password. We have found that the User Information is secured so that
changes cannot be made. When changing the password, it must be changed
twice, once for the server and once for the off-line option. Log into the server
and change the password. Exit the program, log in once more using the off-
line option and change the password again. If this is not done,
CorporateTime will ask for both passwords.

Some CorporateTime Basics

Accessing Help

CorporateTime contains context sensitive help which can be accessed at
anytime by pressing the F1 key on the keyboard or by clicking the question
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mark ( ) if it is available. The help screen will display information pertain-
ing to the selected area on screen or the active dialog box. The general help
screen can be accessed through the Help menu. The help screens operate
exactly as they do in other programs.

Searching

Searching for users, resources, and groups is one of the most important tools
in CorporateTime. After all, it�s impossible to schedule an appointment
unless you can find who to schedule with. The search screen can be accessed

with the search button ( ) in specified dialog boxes or by selecting

Directory|Search Directory... (or keyboard F12) at any time. Accessing the
Directory Search is useful for finding information on a person or resource,
but it does not allow for adding the results to a list. When the search is
accessed with the search button, the search results can be added to a list.

Single User Searches

Single user searches are
accessed when only one
person or resource can be
used. The dialog box
contains two window
tabs with the search
topics. Enter the search
criteria in the field and
click the Search button to
perform the search. The
full information for each
field is not necessary.
Entering partial informa-
tion will return all results that match the criteria.

The search results are displayed in the lower portion of the window. The
window will only display 100 results, with a scroll bar. To narrow the
search, enter more criteria and click the search button again. Print the results
by clicking on the Print button on the lower portion of the window. To view
the specific information on a result, highlight the result and click the Infor-
mation button. Once the desired resource is found, highlight the result and
click the �OK� button to add it.



Page 5CAL PACT CorporateTime Version 4.x

Searching for resources operates with the same functionality. In the Re-
sources tab, there is one special checkbox option labeled �Local Resources
only.� With this option checked, the search will be limited to resources
contained on the local server only.

Multiple User Searches

Multiple user searches are accessed through the search button when mul-
tiple people or resources can be used. The functionality of the search tabs
operate the same, but there is a difference in the results list. The search
results are displayed on the bottom left of the screen. To add search results,
begin by selecting the desired result(s). The keyboard modifier Shift can be
used to highlight multiple consecutive results and the keyboard modifier
Control can be used to highlight multiple non-consecutive results. Once the
desired results have been selected, click the �Add� button to move the
results to the right hand portion. Use the �Add all� button to add the entire
list of search results. To remove names that have been added, select the
name(s) and click the the �Remove� button.

Directory Searches

The directory search is accessed whenever the Directory|Search Directory...

command is selected. The functionality of the directory search operates the
same as the single user search, but you are not allowed to add the search
results to any list. This feature is used mainly to locate information on
people, resources, or groups.

Locating a Person...

In the Directory menu, a special
command Locate a Person... is
available to search for the activity of
a person, resource, or group at a
specific time and date. In the win-
dow that appears, enter the search
parameters and click on the green
check. Notice that a tab for re-
sources or groups is not available.
To search for a resource, precede the search string with r:, re:, or res:. To
search for a group, precede the search string with g:, gr:, or grp:.
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Picking and Choosing Dates

In many of the available windows, a date control bar will appear to specify
or change dates. The single arrows will move the current date backwards or
forward by one single increment. The increment depends on the current
view in CorporateTime. For example, when viewing a single day, it will
move one day; when viewing a month, it will move one month. The double
headed arrows are used to move by larger increments. Once again, this
depends on the view. When viewing one day, it will move one week; when
viewing a month, it will move six months.

To choose specific dates, click this button  and a
small window will open. The pull down menus
available at the top will control the month and year.
The arrows have the same functionality. The single
arrows will move the month; the double arrows will
move the year. Once the month and year have been
selected, select a day from the small calendar view
below. CorporateTime will not recognize any
changes unless a day has been selected in the cal-
ender area. To make things easy, clicking on the
�Today� button will automatically select the current date.

Working with the Agenda

Opening an Agenda

To open an agenda, go to the File menu and select the agenda option.

� An Agenda - This option will allow for opening an individual agenda. In
the dialog box that appears, select the option to modify your own agenda or
enter the name of the agenda to view. Notice that the search button is avail-
able to search for an individual or resource. If a resource agenda is desired,
precede the name with one of the following -  r:, re:, or res:. The last option
available to modify the agenda as a designate is a special option which
allows you to make changes to another person�s agenda. The owner of the
agenda must give you proper permission in order for you to be a designate.
This will most likely be a function used by those on campus who have
designates that maintain their schedule or coordinate calendars for manag-
ers.
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� A Group Agenda - This option is used to create or modify a group con-
taining multiple people or resources. This allows a combined view of the
agendas at the same time, thus making scheduling easier.

� A Group Agenda as a designate - this option is used to open group agen-
das as a designate. As previously discussed, the proper permissions must
be granted in order for the designate to make changes.

Changing the View

There are three possible ways to view a CorporateTime agenda. These are
broken down into the day view, the week view, and the month view. To
switch between the views, use the toolbar buttons ( ).

The Day View

A sample of the day view
is shown at right. The
window is divided into
three separate panes - the
agenda, tasks, and notes.
Icons and colors within
each pane are used to
signify individual ele-
ments for each entry.

Each pane can be resized
by clicking and dragging
the border line between
panes. The mouse cursor
will change to double
headed arrows ( ).

The interval and size of the time blocks of the agenda can be resized to suit
the preferences of any user. Make the height of each time block smaller or
larger by selecting View|Decrease Row Height or Increase Row Height.
This does not change the interval of each time block, just the size. To change
the time interval, select View|Decrease Row Time or Increase Row Time.
Each time block can be changed to represent a time interval between five
minutes and one hour.

Ta
sks

Notes

Agen
da
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The Week View

The week view will
display between five to
seven days in the
agenda depending on
the set user preferences.
The lower pane displays
any notes attached to
each day. Using this
view, the tasks are not
viewable in the window.

The same controls exist
to change the interval
and size of the time
blocks

The Month View

The month view will
display an entire month
with the associated agenda
events and daily notes.
Each day will display as
many events or notes as
possible. If more events or
notes exist, the downward
pointing hand will appear.
The additional items can
be viewed by selecting a
visible item and using the
down arrow on the keyboard. Like other views in Corporate Time, the grid
can be readjusted by clicking and dragging when the mouse is on of the grid

borders. To reset the grid, use the toolbar button ( )

Quick Trick: Click on the date row and the day view for that
day will automatically appear. To switch back to month
view, use the toolbar button.

Agen
da

Notes
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Scheduling Agenda Entries

CorporateTime offers a variety of methods to add agenda entries.

�  Select Agenda|New Entry.

�  Click the New Entry button in the toolbar ( ).

�  Double click the time slot in the Day view or Week view.

�  Select the block of time in the Day view or Week view, type the entry
title, and hit enter. Double click on the entry after to edit settings.

�  Double click an empty region for a date in the Month view.

Using any of the above methods, the entry dialog box will open on screen.
This dialog box consists of six or seven window tabs on a PC or icon catego-
ries on a Mac depending on the method used to create the event.

The General Tab

In the general tab, enter the desired setting for each of the available fields.
Some of the fields may already contain information depending on the
method used to add the new entry.
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Proposed by - This entry cannot be modified. It specifies the entry creator.
Title - This field defines the title for the entry
Location - This field defines the location for the entry.
Date - This field sets the date for the entry. Change the date by (1) selecting a
portion of the field and typing in the entry, (2) using the up and down
arrows, or (3) using the date button ( ) to choose a date.
Start Time, Duration, End Time - These fields define the period for the
agenda entry. A cute little feature available for these fields is the time con-
trol button ( ). Click this button
and a time control will appear on
screen. Click and drag the blue
arrow to automatically adjust the
time for the field.
People and Resources - Invite people, resources, or groups to the agenda
item. In the Add field, type in search criteria and click on the green check.

The group listing and directory search buttons ( ) can also be used as

an alternate method.
Check Conflicts - This button will check the current entry setting against
your own schedule to look for conflicts. If a conflict is found, the conflicting
entry will be displayed in a separate window.

Suggest a date/time - When a conflict is found, the last button in this tab will
open a new dialog box on screen. In this window, set the desired prefer-
ences and click on the List suggestions button. CorporateTime will scan all
agendas and suggest dates and times that match the criteria. If a suitable
date and time is found, select the listing and click the OK button.
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The Options Tab

Importance Level - This field sets the importance level for the entry. A
special indication only appears in the agenda view if the color scheme is set
to the importance level.
Access Level - This field sets the access levels for others who view the
agenda entry.
Tentative Check Box - This check box will mark the entry as a tentative
item. In the agenda view, the entry will appear in a separate color.

The Repeating Tab

This tab is used to automatically schedule the event in the future (i.e. stand-
ing meetings). Adjust the desired setting and click the �List Dates� button.
CorporateTime will list all of the dates. The approximate maximum number
of dates is 55. If the time span is larger, CorporateTime will display a dialog
box. The dialog box will always
appear without listing any dates
on a Mac, but will only appear
on a PC if the Holiday checkbox
is used. This may be a bug in
the program.

The Details Tab

The Details tab is a useful area to include comments or a better description
about the event. The description will be seen by all people who were in-
vited to the event. In the lower portion of the window, an �Attach� button is
available to attach documents (like a meeting agenda) with the event. This is
similar to an attachment for e-mail. Only one attachment can be used with
an event. If a file has been attached, double click on the icon and the file will
be opened. To remove the attachment, click the �Remove� button.

The Linked Tasks Tab

The Linked Tasks tabs allows you to schedule tasks which are linked to the
current event. Click on the �New� button and the New Task dialog box will
appear. This dialog box will be described in detail later. Any new tasks
created in this area will appear in the normal task views available in
CorporateTime. To delete a task, click on the �Delete� button. To keep the
task, but unlink it to the event, click on the �Unlink� button.
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The Reminder Tab

The Reminder tab is used to provide on-screen reminders for agenda
events. Check the radio button to activate the reminder and choose the
desired settings.

The Reply Tab

The Reply window is most commonly used when you are invited to an
event. This window tab allows for confirmation of attendance to an event.
Check off the desired options and close the window. The event status will
be automatically updated in the agenda of the event creator. Notice that a
checkbox is available if another time is preferred. This checkbox works
independently of the other options. A button also exists for e-mailing the
event participants. Click the button and a window will open on screen. Add
any message desired and click �OK� to send the message.

Finalizing the Event

After adjusting all of the event settings, finalize the event by clicking on the
�Create� or �OK� button. If other people were invited to the event, a dialog
box will appear asking to mail the other invited participants. Choosing to
mail the participants will send an actual e-mail to the other participants with
the event details. This is a useful feature for participants who do not have
the CorporateTime software in their office because they can receive informa-
tion on the event. If an invited participant uses CorporateTime, an e-mail
may not be necessary because they will automatically receive notification of
the new event within the CorporateTime program.

Scheduling Day Events and Daily Notes

Day events are scheduled events which occupy the entire day or a large
portion of the day. This event will not block out the time slots in the Agenda
portion, instead it will appear in the notes section of the day view and week
view. Daily notes operate similar to day events. Functionality wise, there is
no difference between a day event and a daily note, they just appear with a
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different icon. The day event appears with a blue flag icon ( ) and the
daily note appears with a red pushpin ( ). Logistically, a day event
should refer to an event which will occupy most of the day; a daily note
should refer to an event which must be accomplished sometime during the
day, but it does not occupy the whole day.

To schedule a day event or daily note, use the toolbar buttons:  for a day
event and  for a daily note. An alternate method to create a daily note is
to double click in the notes section of the day view and week view. In the
dialog box that appears, set the desired setting for each window tab. The
window tabs that appear are the same tabs which appear for scheduling a
new event.

Scheduling New Tasks

Scheduling tasks can be done in a number of ways.

� Select Agenda|New Task or Tasks|New Task.

� Click the New Task button in the toolbar ( ).

� Double click inside the task pane of the day view or the task view.

� Click the �New� button inside the task view.

When the new task com-
mand is created the dialog
box will appear containing
three window tabs - General,
Reminders, and Details. In
the General tab, enter the
task name and adjust the
setting for the task. Notice
that checkboxes exist for the
due date, start date, and
completion date. These
fields can be used, but it is
not necessary. The Remind-
ers and Details tab operate
similar to the tabs described earlier. Once everything has been set, click on
OK and the new tasks will be created.
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Viewing and Editing Agenda Events

In any of the agenda views, the events will be displayed. In the day view
and week view, each event will be color coded, displaying icons showing
the status of the event. In the month view, only the event will be shown. To
view the details on an event, double click the event and the event dialog box
will appear. If you are the creator of the event, you will have the option of
changing any of the event details. If the event was created by another person
and you were invited, only the event details will be shown. You cannot edit
the fields.

Alternate Methods of Editing Events

When using the day view or the week view, the title and time setting for an
event can be changed without opening the event dialog box. Click on an
existing event to select the time block and notice that the appearance of the
event changes. A thick, dark line will appear at the top and bottom. Directly
edit the title by clicking once more and typing. To increase or decrease the
time span of the event, place the mouse on one of the event border. The
mouse pointer will change to double headed arrows ( ). Click and drag to
increase or decrease the time span of the event. To move the entire event to
a separate time, place the mouse inside the time block. The mouse pointer
will change to four headed arrows ( ). Click and drag to move the event
block to another time. In the week view, the event can also be moved be-
tween the days of the week shown.

When working with the month view, events can be moved to different days,
but the time settings cannot be changed. Click and drag the desired event to
different days to move it.

Duplicating or Rescheduling Events

To duplicate or reschedule an event, highlight the event and select
Agenda|Duplicate Meeting or Agenda|Reschedule Meeting. In the dialog
box, make the necessary changes and click �OK.� CorporateTime will pro-
vide a warning if there is a conflict with the selected day/time.

Deleting Events

To delete an event, highlight the event and (1) press Delete or (2) select
Agenda|Delete Meeting.
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Viewing and Editing Tasks

To view all of the scheduled tasks, select File|Open Tasks or use the
toolbar button ( ). Similar to opening an agenda, choose to open your
tasks or the tasks of another person. The task window that appear will
display a listing of all the scheduled tasks along with the respective details.
To make the listing easier to view, click once on a column header and the
list will be sorted by that column.

The In-Tray

The In-Tray is the primary source for managing entries received or sent out
to other users. Open the In-Tray by selecting File|Open In-Tray, using the
keyboard shortcut Control+I (PC) or Command+I (Mac), or by using the
toolbar button ( ). The In-Tray window will appear with four folders for
each user: New entries, Entries you�ve accepted, Entries you�ve sent out,
and Enteries you�ve refused. Click on a folder to open or close the folder.

When you have been invited to an event, the CorporateTime server will
automatically notify you of this event in the New entries folder. By default,
CorporateTime will check for new entries every fifteen minues. To force any
folder to refresh the entries, open and close the folder. Double click on any
of the entries to view the details of the event or to open the fast reply screen.
The desired action for the double click action can be set though the prefer-
ences (which will be discussed later). An alternate method to reply to events
is to click and drag them from one folder to another. For example, to accept
an invitation to a new event, click and drag the entry from the New Entries
folder to the Entries you�ve accepted folder. CorporateTime will automati-
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cally adjust all of the necessary settings.

One quick way to view the participation status for an event is to click on the
icon for the event ( ). The event listing will expand to show the partici-
pants and the associated status. A green check means the participant will
attend; a red X means the participant will not attend; a blue question mark
means that the participant has not replied. If any icon is accompanied by a
gray circle with a red slash through it ( ), this means that the participant
would prefer another time to meet.

Creating and Managing Groups

Often times, events are scheduled with a recurring group of individuals. In
these instances, it is a time consuming and inefficient process to search for
each person when scheduling. CorporateTime has a feature to create groups
of individuals and resources. When scheduling events, the group can be
referenced instead of the individuals. This is usually accessed by the group
icon ( ) or by searching for the group. To create or to edit groups, select
Directory|Manage Groups. Four types of groups exist:

� Public Groups - These groups are available to everyone on the system,
but they can only be changed by the group owner.

� Private Groups - These groups are only available for the group owner.
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� Administrative Groups - These groups are available to everyone on the
system, but they can only be modified by the system administrator.

� Members Only Groups - These groups are available only to the members
of the group.

To create a group, click on the new button. Enter the group name and set the
type of group this will be. Now add the group members using the standard
CorporateTime search feature. In the example below, the members only
group �CAL PACT Staff� consists of three members. Once a group has been
created, use the buttons to modify group settings.

Working with Reminders

Whenever a reminder has been set
for an event, CorporateTime will
open up the reminder window. An
example of a pop-up reminder is
shown here. It displays the details
for the event with buttons at the
bottom of the window.

Snooze - Click this button and a
window will open to enter the amount of time the reminder will snooze for.
After the set time has passed, the reminder window will reopen.

Clear - Click this button to clear the reminder message.

Clear All - Click this button if multiple reminder messages are on screen.
All of the reminder windows will be closed.

Help - Click this button to open the help screen.
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Setting Access Rights

Access rights are the privacy controls used when other users or a designate
works with your schedule. In the window there are four window tabs:
Designate, Viewing, Tasks, and Scheduling. At the lower portion of the field
is an area to add in additional users. Enter the name in the field and
CorporateTime will find the user. To remove any user in the list, select the
name and click on the Delete button.

To set the access privileges, highlight the user name in the list box at the
bottom of the window. In the upper portions of the window, use the
checkboxes to set the individual rights.

Setting User Preferences

All of the user preferences are found in the Options menu. Inside the menu,
each category is defined with its associated preferences. Often when a pref-
erence is changed, you must exit and restart CorporateTime before the
changes take effect.

Agenda

In the Display tab of the agenda preferences, set the hours and days which
are displayed. Use the Notification tab to adjust other preferences. One
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useful setting in the Notification tab is to set the time interval to check for
new entries. The In-Tray of CorporateTime operates like checking mail in
Eudora. If you are invited to an event, CorporateTime is not notified of the
invitation until it checks for new events.

In-Tray

Use the In-Tray preferences to set the display option and the default action
for double clicking on an event listing.

Scheduling

The preferences set in this area only apply when CorporateTime is asked to
suggest another time for an event. The preference for each individual day
can be adjusted. To simplify things, after one day has been set, click the
Apply to All button to apply the current setting to every day.

Entry Defaults

The preferences set in this area are used to control the default values when-
ever an agenda event, task, day event, or daily note is created. These setting
only affect the default value that appears. You can still adjust any of the
values while creating the entry.

General

The General preferences are used to adjust the formats for names and dates
along with the mail client used for e-mail and the time zone.

Off-Line

The Off-line preferences are set for those users who will use CorporateTime
away from a network connection. The settings inside are used to specify the
amount of the information that should be uploaded and downloaded.

Palmtop

The Palmtop preferences should be used by users who synchronize their
CorporateTime schedules with their palmtop computers or PDA�s (personal
digital assistants). One common PDA is the 3Com PalmPilot. If these fea-
tures are needed, refer to the special installation instructions included for
the synchronication plug-in.
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CorporateTime Supplemental - Group Agendas

Opening Group Agendas

To open a group agenda, select File|Open Agenda|A Group Agenda and
the following dialog box will appear.

Enter in all of the people or resources to view and click on the OK button to
open the group agenda. The group agenda is a display of each individual
schedule along with a combined view of all of the individual schedules.
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Along the left side of the window is the combined view. If any individual or
resource is not available, the time block will be marked off in red. To sched-
ule an event with all the the individuals and/or resources in the group
agenda, click and drag on the time blocks in the �Combined� column and
start a new entry as described previously. Each person will automatically be
added in the General tab of the entry details as shown below.

To schedule with one person, select the time blocks for the individual and
start a new entry. It is not possible to automatically schedule with a subset
of the individuals or resources shown. If you are viewing a group agenda
for 5 people and you would like to schedule a meeting with only 4 of them,
start a new entry and modify the General tab of the entry details manually.

To change the individuals or resources shown in the group agenda, use the
toolbar button ( ). This will display the selections for the group agenda.
Modify the listing and click OK to display the new selections.
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CorporateTime Frequenty Asked Questions

Why won�t CorporateTime remember the last window positions or sizes

when I exit and restart the program?

To have CorporateTime remember window positions and sizes, you must
use File|Exit everytime you quit the program. This may be fixed in later
versions of the program.

CorporateTime has some boring colors, I want to use my own colors. Is

this possible?

CorporateTime has 3 set colors schemes that
you can use. These are found by selecting
Options|Agenda...  In the section titled
�Color Meetings by,� use the drop down
arrow and select one of the schemes. If you
would like definitions of the colors in a scheme, select View|Meeting

Colors... and a window will show the colors used for each scheme along
with a definition of what the color signifies. You cannot designate your own
colors to use so turn that artful eye to your desktop, your office, or to me so
I can learn to color match my clothing and bring out the highlights in my
eyes.

In Meeting Maker, I can make the week view begin with current day in

the first column, can CorporateTime do this?

No. In CorporateTime you can only specify the exact day of the week to start
the week view (Options|Agenda). This may change in later versions if the
feature is added in.

How can I turn off that annoying dialog box that asked to mail a message

to the meeting attendees? I�m sure they get enough mail as is.

In the Notification tab under Options|Agenda, unmark the check boxes for
the desired options.

I don�t want other people to view my entry details if they were to open my

agenda. How can I stop this?

Under Options|Access Rights, switch to the viewing tab and ensure that the
�View times only� checkbox is marked off. Now people will only see when
you are not free, not what you are doing.
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